
To the local market:
We introduce your e-book to potential readers.

To over 200 countries:
We will upload your book as an e-book to the world’s largest distributor of e-books.
Your e-book will be distributed to major online retailers for readers over the world to 
buy your e-book.

This includes:
Barnes & Noble (UK and US)
Apple Books (57 countries; dominates Australian e-book market))
Kobo (160 countries)
Walmart (through Kobo)
Odilo (2,100 public libraries in North- and South America, Europe)
Oyster
Scribd
Overdrive (World’s largest library e-book platform serving over 34,000 libraries in 40 
countries)
Yuzu
Blio
Inktera
Baker & Taylor Axis 360
Gardners
Smashwords Shop (200 countries)

Is there a market for my book?

Publishing and self -publishing has become a very competitive industry over the last 
decade.
Millions of e-books are distributed in different languages, categories and countries.
Writers has no excuse not to publish their works.
So, what are the chances for your book to sell? We believe: if you do not try, you’ll 
never know! Some books sell thousands while others don’t. No one can give you a 
guarantee. But writers have a story to tell, it’s not always about the money. 

Brush up your writing skills

Some people, especially readers, think an author sits in front of a desk and the story 
just pours out of their heads. But you know better than that. Writing is hard work. It 
takes courage, time, imagination, knowledge, research, just to name a few.

DiGi Publishers 

publish

your book
Worldwide



An Author is never too old or too skilled to learn.
It’s an ongoing process forever.
Learn new skills. Look what and how other writers do it. What made their books sell. 
Look for writing courses. 

Evalution and Critism

An author always thinks his work is the best. Because they know the story from 
inside out, they tend to ignore good story structure.
DiGi Publishers proofread every manuscript before publishing it. We do not publish 
content that does not represent our values.
It is always good to edit your manuscript to ensure your book is a number one.
We offer full editing and proofreading.

What is an E-book: 

A book composed in—or converted to—digital format for display on a computer 
screen or handheld e-reading device. 

How to prepare your manuscript for publishing at DiGi Publishers

Because we publish your e-book to so many retailers, your manuscript must comply 
to their standards. For your e-book to be readable on multiple devices, it needs to 
published in multiple formats. The most popular e-book file formats--the ones that 
most devices can read--include plain text, Adobe PDF, e-Pub, and HTML. Most e-
readers can display images as well, although some, such as Amazon’s Kindle, have 
only monochrome screens. If you think people will read your e-book on a 
monochrome e-reader, make sure that the images look good in black and white.
Other Formats in which your e-book will be converted for upload: mobi; PDB Palm 
doc., RTF, plain text (no images), HTML.
Devices to read your e-book on:
Apple devices; Kobo reader; Kindle reader; Sony reader; any laptop or computer; 
smartphones; other e-readers; Macintosh; i-Phones; tablets, Smash reader.
Please look at the following points on how to format your manuscript before sending 
it to us.
We will not upload a manuscript that does not comply to our standards. Note 
that the following common errors may prevent your book from being published:
**more than 4 consecutive paragraph returns in a row (that is, hard returns, created 
by pressing the ENTER key) to arrange text on the page (this creates blank e-book 
pages on small-screened e-reading devices).
** tabs (eliminate all tabs which you created by pressing the Tab key)
** Improper indents made with space bar spaces or tabs (a common bad habit of all 
authors) Instead, code your paragraph style to define a special first line paragraph 
indent: see Paragraphs and Indents in a later post).
** exotic fonts (instead stick with Times New Roman, Garamond and Arial; 
** large font sizes (11 or 12pt is best. 14pt is a recommended maximum)
** text in columns (some e-readers don’t support columns)
** text in tables (Some e-readers don’t handle tables. Import tables as images 
instead)
**text in text boxes (Some e-readers don’t support text boxes. Use the method 
explained later to remove all special styles.)



**multiple conflicting paragraph styles for your body (for example, don’t mix Normal 
style with Body Text style)
**automatic footnotes (No automatic footnotes)
** No headers and footers
**No automatic numbering or bullet lists
**text wrapped around floating images (instead, right-click on the image, choose the 
Format Picture option: Advanced: In Line with Text, then use Word’s center button to 
center) 
**No drop caps
** No alphabetical index
**No Improper Paragraph Separation – Paragraphs require either first line 
paragraph indents or the block paragraph method. Otherwise your paragraphs run
together and it becomes unreadable because your reader’s eye can’t distinguish 
where one paragraph ends and the next begins. Use one method or the other 
(indents are best for fiction and many non-fiction, blocks are usually only for non-
fiction), but don’t use both. If you’re aiming for the block style, do not add paragraph 
returns between paragraphs on empty lines (to create the blank line). Instead, modify
your paragraph style to add a 6 pt trailing “after” space following each the paragraph 
(see Paragraph Style in a later post).

1) Format:
Must be in Word.doc not Word.docx. Save as Word 97-2003 or any version of Word. 
Documents in other formats will not be accepted.

2) Font: use Times New Roman/ Arial/ Garamond. Do not use more than one font on
a page except for headings. Example:

Chapter 1
Home Coming

Italic works well to alter the font. You may also use bold or underline.

3) Size of document: not larger than 10MB (images included)

4) Page Numbers: 
No page numbers must be used. Most of the e-readers use flowing text where the 
pages are automatically set in order. Page numbers are set in headers and footers. 
Do not use this. 

5) Font Colour: 
Do not use any colour for you letters other than black. This should be altered with 
“Automatic”.

6) Word’s Autocorrect 
Turn off Word’s AutoCorrect: AutoFormat As You Type and AutoFormat features: The
reason we turn off these AutoFormatting options is because Word will cheerfully and 
automatically mess things up again as you make the corrections.
Word 2007: Click the round Office Button (top left corner), then click the Word 
Options button.
Click the File tab, then click the Options button.
Click the Proofing option, then click the Autocorrect Options button.
Click the Proofing option on the left, then click the AutoCorrect Options button.



Click the AutoFormat As You Type tab 
Uncheck all the check boxes on this window except the “Straight quotes”box. Click 
OK.
Remember, formatting your book is like stripping away all special styles from your 
manuscript, if you have these in your book. Keep it simple!!

7) Page layout
Margins: Default
Orientation: Portrait
Size: A4 or Letter (NOT A5!!!)

8)  Paragraphs and Indents

You can use one of two styles: first indent style (usually for fiction where every new
paragraph or dialogue is started with an indent) or block paragraph style where 
every row start at the left with no indents. This is for non-fiction.
Is you have already written your manuscript, you have to strip the fancy things out of 
your Word manuscript.
There are 2 ways you can strip the fancy things out:
You can go through your manuscript and change each style, one at a time (using the 
Format Painter it can actually be done quickly and easily), or you can select your 
whole manuscript and change everything to the Normal style. Then you will need to 
go through your manuscript again, and add the Heading styles, italics, bold, etc. 
For this method:
Open your Word file (remember it must be the .doc version).
Make sure Track Changes in Word is turned off.
Place your pointer in the left hand margin (outside of the text). See the pointer arrow 
below.
Hold down Ctrl and click your left mouse button.
Everything in your manuscript will now be selected.
Or you can press CTRL A and it highlights all your work. Click the Normal style in the
Styles toolbar.
Everything in your manuscript will now have the Normal style.

Paragraph Styles
a) Block Paragraph Style
NOTE: Do not follow this step if you already created a proper first line indent as 
explained below.
Select a paragraph (if you’re not converting an already written manuscript, type any 
text and select it).
Click the Paragraph style drop-down arrow.
In the Spacing section, change the After distance to 6 pt (this will create a space of 6
points after each paragraph). Not less than 4pt or more than 12pt for this space.
Click OK.

IMPORTANT: NEVER, NEVER allow any entry into the “At:” field (see above), 
otherwise your book may become unreadable in the HTML reader and in the ePub 
format. 
You can set the line spacing to Single line spacing or 1.5.
Click OK.

b) Paragraph style 2: First Line Indent 
Select a paragraph (if you’re not converting an already written manuscript, type any 
text and select it).



Click the Paragraph style drop-down arrow.
Click the Special drop-down menu and choose First line. The default distance (the 
By dimension) should be correct. This distance should not be more than 1.27 cm 
(0.5”).
Leave the Before and After Spacing at 0.
Click OK.

Your font color should be set to Automatic. If your font color is set to Black, change 
it to Automatic. Some e-reading devices allow the reader to set their device to night 
mode, which will display your book’s test as reverse type if it’s set to Black.
If you have a poetry book, cookbook, or learning materials, please contact us for 
the specific formatting for these types of books.

Centering Text
Do not use Word’s button to center text (e.g. the title and copyright page, or “***” 
separators) 
Rather create a specific style for centered text.
Select the text in your document (or type any text to use in order to create your 
style.)
Click the drop-down arrow under Change Styles to open the Styles menu.
At the bottom of the Styles menu, click the New Style button.
On the Create New Style from Formatting window change the details.
Type the name of your newly created style, try to make it as descriptive as possible 
so as not to confuse yourself for future use, e.g. center text.
If this style is going to be used as a chapter heading, change the Formatting as 
needed. As this is a heading style, you should only change the Font, Font Size, and 
make it Bold. Don’t change the font color.
Remember your font color should be set to Automatic. 
Click OK to save your new style.
Now, when you want text to be centered, you can apply the style you created. As 
easy and simple as that (or any other style you set), you can just use the style button
to apply the changes you need.

Activate the Paragraph marks and other hidden formatting symbols in your Word 
menu bar on top (Marked with red on image below) This is a magic tool to use for 
editing your work. 

When this tool shows any paragraph returns: Go to FIND and REPLACE on far left 
of Word doc. Find: ^p In Replace with: leave blank- Apply to whole document.
When writing your book, do not make indents with the tab button or space bar.

How to create your own Style:
Click on “paragraph” your Word menu on top and make a custom style for your 
whole document.
Click “normal” style >click on 
Click Modify



Here you can defy your font for your text (Times New Roman/ Arial/ Garamond), the 
size (12), colour must be on Automatic.

You can name this style what you want, example 
Content 1.

Click Format at bottom: select paragraph
Keep this style with a “first line” indentation at the left.(See picture above- highlighted
in blue)
The line spacing can be single or 1,5. Not bigger.Click OK.
If your manuscript is not in this format, press CTRL+A, this highlights all your works. 
(Remember always to keep a copy of your work!) Click on your Style named content 
1. All your content will be formatted in that style.
For fiction story books you need to start every new paragraph or dialogue with an 
indentation like this.
For your first paragraph at beginning of a new chapter, no indent must be used. Do 
the same as above, name it Chapter beginning of content 2 and at the Indentation 
area> Special> None.
You can highlight the first paragraph of each chapter and just click on your style’s 
name. It will convert it to right style.

9) Page and section Breaks

If you insert page breaks into your Word document, some versions will honor them, 
but formatting options will be lost in most other file formats (e.g. ePub, Mobipocket, 
etc.), which strip page breaks and section breaks. Loss of page breaks is okay in an 
e-book, because you can’t predict the font size or screen size the reader is using, 
and you want to have continuous reflowable text. The worst thing that will happen is 
paragraphs may become artificially close or too separated.
Best is to remove all section breaks from your document. They create unnecessary 
blank space in your ebook.
So, how do you seperate chapters or sections so that the reader can see it? 

The best way if you want to separate chapters, insert a consistent number of 
paragraph returns (maybe three or four), or use a combination of two paragraph 
returns,(By pressing ENTER) followed by centered text characters such as ~~~~ or *



* * *, followed by a couple more paragraph returns and possibly chapter headings if 
you have them. Do not use solid separator bars.

A good rule is to never use more than four consecutive paragraph returns to 
arrange text on the page.

NOTE: Many ebook reading devices such as the Kindle and iPad will add 
extra padding after each paragraph return, so if you add multiple paragraph returns 
this can create excessive spacing between paragraphs.

10) Headings:

Click on Styles on your Word menu on top. Click Heading 1 >Modify
You can name your heading or keep it Heading 1. Use this for your chapter headings
or section headings. Adjust the Font, size, leave on Automatic, and click on the red 
highligted boxes. (Picture below) Adjust your settings for your heading. 
Click Format at bottom. Click Paragragh>

11) Make a Word Template 

If you plan to write multiple manuscripts for e-
books, design a basic layout and save it as a 
Word template so that you can use it for
each new book. 
Save the Design as a Reusable Template
To save this design as a reusable template,
choose File, Save As, and in the 'Save as
type' drop-down list, select Word Template (*.dotx). Click the Templates entry below 
the 'Microsoft Word' name in the top-left corner of the Save As dialog box so that the 

To center your heading: see 
picture.

Remember to click OK each time 
you make adjustments.

Highlight your heading, click on 
heading 1 and it will be formatted
to your style.

Do this for every heading. For 
smaller headings in your sub –
sections: do the same with 
Heading 2 and Heading 3 etc.



file will be saved into the Templates folder. Type a name for the template, and 
click Save. You can now close the document, as you no longer need it.
To create a new e-book based on this template, choose File, New, My Templates, 
and then select the ebook template you just created from the Personal Templates 
list. Click OK, and you’ll have a brand-new ebook document with all the prompts and 
layout in place.
“Save in” Format: 
File.>Save as>Word doc. (Word 97-2003 or other version, not in Word.docx

12) Front matter of your book

The front matter of book consists of:
1) The cover page (We design it for you, included in the price)
2) The Title page
3) Copyright page (We insert this)
4) Quotes/other books by this author (Links to the back of your book for readers to 
see)
5) Table of Contents
6) Prologue or foreword
 
Blurbs: Do not use blurbs (testimonials)

13) Add the Title Page

This is where you start with your book. 
Type the book title, subtitle, and author name, along with any other details that 
should appear here. Select the title text and format it by clicking the Title style in the 
Styles gallery on the Home tab of the Ribbon toolbar. Select the subheading text and
click the Subtitle style (if this doesn’t appear in the Style gallery list, press Ctrl-Shift-
S to display the Apply Styles dialog box, type Subtitle into the field, and click Apply.
Example:

The Girl Next Door

Marjorie Newton

Click a style in the Styles gallery to apply it to the selected text.
Select and format all of the other text on the title page, too; for example, you can 
choose the style Emphasis for the author name and other information.
If a style does not format text the way you want it to look, you can change the style 
by right-clicking its name in the Style gallery and choosing Modify. Make your 
desired changes to the font, font size, and any other settings in the Modify Style 
dialog box, and click OK to apply them. All text formatted with that style will change 
automatically to match the new settings.



14) Table of Contents
As soon as you’ve finished the title page, you’re ready to start a new page. 
Choose Page Layout, Breaks, Page to begin a new page. If this next page is to be a 
table of contents for the book, type a title such as Table of Contents and then 
choose References, Table of Contents, Insert Table of Contents. Set 'Show Levels' 
to 1 or 2 depending on how many heading levels should display, select a format from
the Formats list, and click OK twice. You will see a message stating 'No table of 
contents entries found', which is to be expected since you haven’t created any yet. 
Later, when your book does have content, you can update the table of contents by 
clicking that message and pressing F9.
When you use this method, Word automatically insert links to the section/chapter 
headings. So, write your manuscript, use HEADING 1 for this headings!!! And when 
finished, do as above mentioned.
Table of Content can also be you Index.
No alphabetical index may be used. Use numbered list. Don’t forget to take out the 
page numbers if you had it included. Remember: NO page numbers. (Use hyperlinks
to take the reader to the section/ chapter.)
Now, when you want text to be centered, you can apply the style you created. As 
easy and simple as that (or any other style you set), you can just use the style button
to apply the changes you need.
Don’t mix font size variations too much – it will make your ebook look unprofessional 
and amateur. Go with 12pt for the body text, and 14pt for the Title on the cover page 
and the headings.
Center your text. You can insert hyperlinks in your table of content linking directly to 
that chapter, section heading or category.(If not used the above method)

15) Your first chapter:

Start a new page by choosing Page Layout, Breaks, Next Page. 
Type the first chapter heading, and format it using the Heading 1 style. 
Add second-level headings if you desire, and format them as Heading 2 style. It’s 
important to use Heading 1 style for chapter headings and Heading 2 style for 
subheadings, because Word automatically configures them to be the first- and 
second-level headings in the table of contents.
Modify your heading style to suit your font, size of font, etc.
Add some placeholder text for the chapter content, such as Text goes here, and 
format it using the Normal style. 

16) Set Up the Next Chapters

To set up the next chapters, choose Page Layout, Breaks, Page and again add the 
chapter title (or placeholder title text), subheadings, and placeholder text for this 
chapter. 
Format these items using the same styles as you used for Chapter 1. Alternatively, 
you can copy and paste the placeholders from Chapter 1 and update them. Continue
in the same way to add more chapters as necessary.

17) Numbered List and Bullet Points:



They’re used to categorize, separate, and emphasize bits of information without 
confusing the reader with huge blocks of text.
Under NO circumstance use Microsoft Word’s built-in options for bullet points and 
lists. In Microsoft Word for PC, you’ll see them in your Home tab up top, in the 
Paragraph section. 

Why not Microsoft Word’s built-in options?
Because when you put the .doc through the one-size-fits-all conversion software, it 
doesn’t recognize Word’s built-in options and leaves you with a messy e-book.

Numbered Lists
Put the number, followed by a period and a space or create a style just for numbered
lists. If you do this, you’ll have to create one specifically for numbers 1–9, another for
numbers 10–99, etc.
Or create your own numbered style list: Press ALT+7
Equation Options>Justification> left

Type 1) in the box as shown below: 

Click left. Go to Styles>Normal> New style (bottom right)
Name your new style ex. Numbered list. See that it matches the picture below>Click 
ok.

1. Now you can just click on the name of your style (numbered list)
2. Press Enter 
3. It will automatically give you the numbered list.



 18) Do Not Insert:

  online pictures/ tables/ page breaks/ blank pages/cover page/ comments/ text 
boxes /word art/ drop caps or symbols/ header/ footer/ page numbers/ NO 
AFFILIATE LINKS. If your manuscript has page numbers: CTRL A >Insert>page 
number>Remove page number. 

19) Insert images

Images in digital formats such as e-books are a complex issue. Not all e-readers are 
image friendly, as some only read in greyscale and not in colour. So, decide if your 
images are a nice-to-have but not a need-to-have, or vice versa. Images make your 
books content much larger, so a lot of images quickly set the point of the size of 
overall size of 5 MB. The file Upload Limit is 5Mb. The source .doc file you upload 
must be less than 5 megabytes in size.
To determine your file size, right-click on your Word .doc file in Windows Explorer 
and click properties. The file size will display on the General tab.
If your file is greater than 5Mb, you can reduce the size of your images as follows:
NOTE: In Word 2010, when you add a picture to the file, it is automatically 
compressed using the number specified under Image Size and Quality on the 
Advanced tab of the Options command. By default this is set for print (220 ppi), but 
you can change this option.
IMPORTANT! This setting applies only to pictures in the current file or the file 
selected in the list next to Image Size and Quality.
Click the File tab.
Under Help, click Options, and then click Advanced.
Under Image Size and Quality, click the file that you want to set the default picture 
resolution for.
In the Set default target output to list, click the resolution that you want.
NOTE: Screen resolution is suitable at 72 dpi.

Insert Image
Click your pointer at the place where you want the graphic image, e.g. if you want to 
place an image at the start of a paragraph, click your pointer at the start of the 
paragraph Press enter to insert an image at the start of a paragraph.
click the INSERT tab (menu top) Click the Picture button.
Navigate to the folder where your graphic images are on your hard drive.
Click the image you want to place in your ebook.
Click Insert.



Left click- choose Size and Position in dropdown menu> don’t change height or 
width
If you want to change the size- do it on the 
SCALE 
Height Width 

Do not use floating images.(If you can move picture around it’s floating) 

Right-click on the image, choose wrap text> In line with text.
Can center the image with Word menu top.

20) FOOTNOTES AND ENDNOTES

 The most obvious difference between footnotes and endnotes is the placement of 
each within a paper. Footnotes are found at the bottom of a page (i.e. in the footer) 
and endnotes are located at the end of a complete document, or sometimes at the 
end of a chapter or section.
While the content in footnotes and endnotes can look the same, they serve different 
functions. Footnotes are used as a citation vehicle for a short citation, while 
endnotes can contain more text without compromising the format of the paper. They 
each also typically use a different numbering system, which allows the reader to 
determine where they should look for the additional information (either in the footer 
of the page, or at the end of the document).
Footnotes Don't Really Exist in eBooks
In print editions, the difference between footnotes and endnotes is 
that footnotes appear at the bottom of the page of content in which they appear, 
while endnotes appear at the end of the applicable chapter or in a section in the 
back matter entitled Notes.
Why You Can’t Have Footnotes
Footnotes can’t exist on a Kindle or any other e-reader because e-readers don’t 
have headers and footers. Since footers are what footnotes are placed in, there just 
isn’t a way to have them in an ebook. In light of that, what we must to do is turn all 
of those footnotes into endnotes.
If you have already properly inserted your footnotes in Word, then you have a very 
easy task in front of you. It all starts with going to your “References” tab on the top 
toolbar of Word. You’ll see a little section for footnotes. Looks like this:

Click where the red arrow is pointing, and you’ll see this:

100% or 
50%

100% or 
50%



Click on “Convert…” (where the red arrow is 
pointing). You’ll see this:

Click “Okay.”
You’re done. All of your footnotes should now be endnotes in numerical order at the 
end of the document. If, for some reason, you haven’t yet inserted the footnotes or 
endnotes properly in Word, you’re in for a little bit of work. 
All you really need to do now is insert your endnotes with Word’s built-in option.
In same “References” tab, just click “Insert Endnote” wherever you want one. Do it 
throughout your document. Once you have all of them done, your task is finished.
Note: It’s okay to have headers and footers in the document so long as there isn’t 
anything in them. You don’t have to delete the headers and footers themselves, only 
what’s inside.
Deleting What’s Inside Headers/Footers
Simply go to where your page number is and double-click. That will allow you to 
delete anything and everything in the header or footer. Rinse and repeat with all of 
them.
For e-books, the end result and experience for the reader is the same whether or not
the endnotes are done by chapter or by book. It doesn’t matter to them what the 
numbering system is. When they click to get to the endnote, they don’t know if 
they’re at the end of the chapter or the end of the book. They still have to click to get 
to the endnote and click to get back. 
:   

21) Clean Up Your Document!

For this task, you need nothing but your trusty Search and Replace option. 
Double Spaces
Double spaces after a sentence are no good, at least for an e-book. Replacing them 
all is easy. 
In the “find” bar, hit the spacebar twice. It will look blank, but we know that there’s 
something there, don’t we? In the “replace” bar, just hit the spacebar once. Click 
“Replace All.” Keep clicking “Replace All” until there are zero items found. That way 
you know you got them all.



Paragraph Spaces
Now the time has come for us to remove spaces at the end of paragraphs and at the 
beginning of them. Search and  Replace.
In the “find” bar,  put “ ^p” Notice the blank space before the ^ symbol. That’s 
intentional as hell. Now, replace that with just “^p” without the space. Ignore all those 
quotation marks, of course. It should look like this:

Click “Replace All” as many times as it takes.
Now, do the same thing, only instead of a space before the ^p, put one after. Like 
this—“^p ”
Replace them with the same “^p” as before.
Removing Double Lines
Double lines where you’ve hit the “enter” key twice to manually put spaces in 
between paragraphs.
Search for: “^p^p” with no spaces in there. 
Replace with: “^p”
That takes care of that. 

Tables: To remove Tables borders: Highlight the table>Border>no border.

Go through the doc and make sure nothing looks askew
It could be a chapter heading you missed; two separate words together without a 
space in between; an image you forgot to center, or a paragraph that’s in your 
original font instead of Times New Roman, or whatever you set your Normal style to.

22) Quotation Marks “ Hi,........”

 
When to use quotation marks
Quotation marks are for when you want to use someone else’s words in your 
writing.Example:
Peter said, “I really hate when it’s hot outside.”
You can write about the same thing without using the quotation marks, with a couple 
of changes:
Peter said he hated when it was hot outside.
 
The first sentence contains a direct quote, a quote in which you report the exact 
words Peter used. The second sentence contains an indirect quote, which is a 
paraphrased version of what Peter said. Quotation marks are used only with 
direct quotes.
This rule isn’t just for speech. If you’re quoting a written source, you should still put 
the quote between quotation marks unless you plan to paraphrase it.
Quotation mark rules
The first rule of using quotations is that once they’re opened, they have to be closed.
The person reading your work needs to know where the quote starts and where it 
ends. “...............”



If you’re quoting a complete sentence, you should start the quote with a capital letter,
even if it’s the middle of a sentence. Example: My mother always says “There is a 
way or no way.”
In a sentence:”Where are you going?”-Outside the question mark
“Where are you going, Peter?” she asks.
If your’e quoting a phrase or a part of a sentence, don’t start the quote with a capital 
letter: He called them “beauty and the beast” and turned around.
 “The problem with opinions,” Paul explained, “is that everyone has one.”
“You never listen to me,” she raise her hand and points a finger to him, “what the hell
do you want me to do?”
 “There was a storm last night,” Paula said.
Paul, however, didn’t believe him. “I’m not sure that’s exactly what happened.”
Victor was aware of what he called “Paul’s weakness triangle”: he was half deaf, 
slept like a dog, and was prone to lying.
Peter saw an argument coming, so he muttered only “But I saw it”; this was going to 
be a long night and he didn’t want to start it with a fight.
Lindy asked them, “Why do you guys always fight?”
Did the dog bark every time he heard Stanley say “I’m bringing dinner”?
Paul put his riffle down. “Why did you shoot!”
“’The Homecoming’ is my favourite chapter in the whole series,” Peter said.
Single quotation marks are used for quotes within quotes.
You can use qutation marks to emphasize word/s or titles: “inhale” means to take a 
breath. But you can also italicize such a word: inhale means to take a breath.
Ex: They say he is a “professional”, but people know better.

22) Links in Word

Linking the Table of Contents (TOC) 
Hyperlinking the TOC is especially important for nonfiction books. Your readers need 
to be able to navigate quickly and easily to any section of the book they want to.
There are a few prerequisites to hyperlinking your TOC. 
You have already done your Table of Content in your front matter of book after the 
Copyright right page (Which we put in)
Make sure it’s left aligned. Don’t center it or give it a first-line indent.
Make sure your ToC is bookmarked. 
Just click your cursor at the beginning of where it reads “Table of Contents” on your 
ToC page. Then, go to your “Insert” tab on Microsoft Word’s top toolbar. Click on 
“Bookmark.” Now, enter the name of your bookmark, which should be simply TOC. 
Click “Okay.” 
Make sure every chapter title is in Heading 1 style, and all your sub-chapters are
either Heading 1 or Heading 2 style. 
Every section of your book that you want hyperlinked in the ToC must be in a 
Heading style.
Now link your TOC to the corresponding chapters in your book. Let’s say your first 
chapter is “Chapter 1:The Homecoming.” 
Go to your “Insert” tab on your toolbar and highlight your chapter title.
Very important: Highlight only the text. Don’t highlight any blank space after the text.
1. The Homecoming
Once that’s highlighted, click on “Hyperlink” on your top toolbar.
Once the window opens up, you’ll see a column on the left. On that column, select 
“Places in this document.”(on left side). All that means is that you’re making a link to 
something in the document..
Once there, it will give you a list of everything you have in Heading 1 style. Just 
double-click the corresponding heading on the list, and there you go. It’s hyperlinked.



Rinse and repeat with all of your chapter titles.It will turn your chapter titles in the 
ToC to blue text, and you can press Ctrl+right-click to follow it.
 This is really a bonus for readers in non-fiction books to go to different sections or 
categories within your book.

To change the address or display text of a hyperlink you added, right-click the link 
and click Edit Hyperlink.

To change the appearance of a hyperlink, such as font style, size, or color, right-click 
the link and click Font on the shortcut menu, or click a style option on the mini 
toolbar that appears.

To customize the ScreenTip that appears when you rest the pointer over the 
hyperlink, right-click the link, click Edit Hyperlink, click ScreenTip in the top-right 



To remove the hyperlink completely, select it and then press Delete. or Remove 
hyperlink.

22) Summary: 

 Make sure your manuscript is on standard and fully complete.
 Manuscript must be written in Microsoft Word doc. only. No other format will 

be excepted.
 Any specifications about the layout must be done before submitting.
 Images and photo’s are difficult for digital reader devices. If you have lots of 

photo’s or images please let us know.
 See to it that your manuscript is edited as far and best as you can.
 Chapters/sections must well be defined. Do not use page breaks.
 Your manuscript must be in ONE file. Each chapter can be separately placed 

in this file. Not each chapter in it’s own file.
 No headers or footers or page numbers
 No text boxes or tables.
 No diagrams or forms. 
 In case of diagrams/columns/ save it as a picture in PNG format. Insert as 

picture.
 Do the same with your images and/or photo’s.
 Do not use drop caps.
 Content of book: we maintain a high standard on all our e-books. No e-books 

will be published if not proofread. We give our readers quality content.
 Font: try to use one font throughout your manuscript. Times Roman/Ariel/ 

Courier
 Font size: 12 Headings 14
 Page layout: portrait, not landscape.
 Save your work and make sure to backup. Also the edited manuscript.( after 

you and your editor worked through it)

22) The End of Your Book

Add a ### centered on the next line to signify the end.
###

You can consider adding a personal message or even link to your website, blog, 
email adress . If you have other books published at DiGi Publishers, please remind 
us about it, so we can link it at the back of your book to our website where readers 
can buy it.

About the Author:

You can insert a short bio and even a photo of you. 
Remember the formats and way to insert it. 

Other titles:
Titile 1 
Title 2

 You can add your facebook/ twitter/ website/ blog/ email if you wish.
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